
DocuPrint C2255
PostScript® User Guide



Adobe, Adobe Type Manager, Acrobat, Adobe Reader, Adobe PostScript 3, and the PostScript logo are either
registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other

countries.
Microsoft, Windows, Windows Server, and Windows Vista are either registered trademarks or trademarks of

Microsoft Corporation in the United States and/or other countries.
Permission has been obtained from Microsoft Corporation for use of software screen shots.

Macintosh, Mac OS, AppleTalk, EtherTalk, and TrueType are trademarks of Apple Inc.,
registered in the U.S. and other countries.

All product/brand names are trademarks or registered trademarks of the respective holders.

XEROX, The Document Company, and the stylized X are registered trademarks of Xerox Corporation.
All Xerox and Fuji Xerox product names are either registered trademarks or trademarks of Xerox Corporation

or Fuji Xerox Co., Ltd.

Important
1. This manual is copyrighted with all rights reserved. Under the copyright laws, this manual may not be cop-

ied or modified in whole or part, without the written consent of the publisher.
2. Parts of this manual are subject to change without prior notice.
3. We welcome any comments on ambiguities, errors, omissions, or missing pages.
4. Never attempt any procedure on the machine that is not specifically described in this manual. Unauthor-

ized operation can cause faults or accidents. Fuji Xerox is not liable for any problems resulting from unau-
thorized operation of the equipment.



3

Contents

Preface ..............................................................................................5
Types of Manuals ..............................................................................6
Conventions .......................................................................................7
Organization ......................................................................................8

1 Installation and Configuration on Windows ...............................9
About the CD-ROM ...........................................................................9

Included Software ............................................................................. 9
Hardware/Software Requirements .................................................. 10

Supported Hardware ........................................................................10
Supported Operating Systems .........................................................10

Installing the Print Driver .................................................................11
Installation Procedure - Windows 2000/Windows XP/
Windows Server 2003 ..................................................................... 11
Installation Procedure - Windows Vista ........................................... 18

Configuring the Print Driver .............................................................23
[Device Settings] Tab ...................................................................... 24

Setting Items .....................................................................................24
[Configuration] Tab .......................................................................... 26

Setting Items .....................................................................................26
[Advanced] Tab ............................................................................... 28

Setting Items .....................................................................................28
[Paper / Output] Tab ........................................................................ 31

Setting Items .....................................................................................31
[Image Options] Tab ........................................................................ 34

Setting Items .....................................................................................34
[Layout] Tab .................................................................................... 37

Setting Items .....................................................................................37
Using the Online Help ......................................................................39

2 Installation and Configuration on Mac OS...............................41
About the CD-ROM .........................................................................41

Included Software ........................................................................... 41
Hardware/Software Requirements .................................................. 42

Supported Hardware ........................................................................42
Supported Operating Systems .........................................................42
Print Driver ........................................................................................42
Plug-in Installer .................................................................................42

Installing the Print Driver .................................................................42
Installation Procedure (Mac OS 8.6/9.2.2) ...................................... 43
Configuring the PPD File (Mac OS 8.6/9.2.2) ................................. 44

When Using EtherTalk ......................................................................44



4

When Using the USB Port ................................................................46
Installation Procedure (Mac OS X 10.3.9/10.4) ................................49
Adding the Printer  (Mac OS X 10.3.9/10.4) .....................................51

Procedure - Mac OS X 10.3.9 ..........................................................51
Procedure - Mac OS X 10.4 .............................................................54

Configuring the Print Driver .............................................................56
Installable Options (Mac OS 8.6/9.2.2) ............................................56

Setting Items ....................................................................................56
Installable Options (Mac OS X 10.3.9/10.4) .....................................58

Setting Items ....................................................................................58
 Printer Specific Options (Mac OS 8.6/9.2.2) ...................................59

Setting Items ....................................................................................60
Fuji Xerox Features (Mac OS X 10.3.9/10.4) ...................................64

Setting Items ....................................................................................64
Image Options (Mac OS X 10.3.9/10.4) ...........................................68

Setting Items ....................................................................................68
Job Accounting (Mac OS X 10.3.9/10.4) ..........................................71

Setting items .....................................................................................71
Job Type (Mac OS X 10.3.9/10.4) ....................................................73

Setting Items ....................................................................................73
Watermark (Mac OS X 10.3.9/10.4) .................................................75

Setting items .....................................................................................75
Installing the Screen Fonts ..............................................................77

3 Barcode Settings .....................................................................79
About Barcodes ...............................................................................79

Font Types and Character Codes ....................................................79
Sample Program and Output Result ................................................80

Character Code Tables ...................................................................81
JAN Character Code Table ..............................................................81
Code 39 Character Code Table .......................................................82
NW7 Character Code Table .............................................................83
Code 128 Character Code Table .....................................................84
ITF (Interleaved 2 of 5) Character Code Table ................................88
Customer Barcode Character Code Table .......................................90

Barcode Sizes .................................................................................91

4 Appendix .................................................................................93
Built-in Fonts ....................................................................................93
Notes and Restrictions ....................................................................98

Print Driver .......................................................................................98
Troubleshooting ................................................................................98

5 Index........................................................................................99



5

Preface

Thank you for purchasing the DocuPrint C2255. 
This guide describes the software included on the PostScript Driver Library CD-ROM 
and how to install and configure a PostScript print driver on your computer.
To get the most out of this printer and to use it effectively, make sure to read this guide 
before use. 
This guide assumes that you are familiar with your operating system, network 
environment, and the basic operation of the printer. 
Please refer to the User Guide for the PostScript-related menus that appear on the 
printer’s control panel.
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Types of Manuals

The following manuals are provided for this printer.

Setup Guide Provides step-by-step instructions on how to set up your 
printer.

Quick Reference 
Guide

Provides information such as how to get ready to print, basic 
operating instructions, and troubleshooting tips. This guide 
also includes instructions on how to install options, including 
the Memory, the Hard Disk Unit, the Future Enhance Kit,  the 
Font ROM and the Parallel Port.
For more detailed information and information about topics 
not covered by this guide, refer to the "User Guide".

User Guide (PDF) Describes how to get ready to print and set various print 
features. It also covers control panel menus, troubleshooting 
tips, and maintenance information.
• This guide is on the CD-ROM in the Driver CD Kit, under 

[Model-specific Manual (PDF Document)]

CD-ROM 
Documentation

Describes how to set up the printer's operating environment, 
and how to install a print driver and various Fuji Xerox 
software.
• This guide is on the CD-ROM in the Driver CD Kit.

PostScript® User 
Guide (PDF)
(this guide)

Describes how to set up your printer as a PostScript printer 
and the features that can be configured on your print driver.

Installation guides for 
the optional 
accessories

Most optional accessories (sold separately) come with 
installation guides.
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Conventions

The following conventions are used throughout this guide:

Text in
square brackets ([   ])

Indicates the names of windows, dialog boxes, tabs, buttons, 
features, menus, setting items, and options that appear on 
your computer screen.
Example:

• You can also specify the path by clicking the [Browse] 
button and navigating to the print driver folder.

Greater-than sign (>) Indicates the hierarchies of the menus, setting items, and 
options that appear on your computer screen. 
Example:

• [RGB Color Temperature] can be configured when the 
[Paper / Output] tab > [Output Color] is set to [Color].

Italic typeface Indicates references to other sections and chapters.
Example:

• See Print Driver Properties on page 10 to configure the 
print driver.

Note A statement that provides additional information.
Example:
NOTE: Clicking the [Defaults] button restores the defaults.
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Organization

This guide is organized into the following chapters. The summary of each chapter is as 
follows:

Chapter 1
Installation and Configuration on 
Windows 

Describes how to install and configure a 
PostScript print driver on Windows 2000, 
Windows XP, Windows Server 2003, or 
Windows Vista.

Chapter 2
Installation and Configuration on 
Mac OS 

Describes how to install and configure a 
PostScript print driver, and how to install screen 
fonts into Mac OS.

Chapter 3
Barcode Settings

Contains information such as the types of 
barcode supported by the printer, the character 
codes assigned to barcode characters, and the 
print sizes of barcodes.

Chapter 4
Appendix

Lists the PostScript fonts built into the printer. 
Also describes the notes and restrictions that 
apply to the printer.
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1 Installation and Configuration on 
Windows 

This chapter contains the following information:

• About the CD-ROM
– Included Software
– Hardware/Software Requirements

• Installing the Print Driver
– Installation Procedure - Windows 2000/Windows XP/Widows Server 2003
– Installation Procedure - Windows Vista

• Configuring the Print Driver
– [Device Settings] tab
– [Configuration] tab
– [Advanced] tab
– [Paper / Output] tab
– [Image Options] tab
– [Layout] tab

• Using the Online Help

About the CD-ROM

This section describes the contents of the PostScript Driver Library CD-ROM and the 
system requirements for using the PostScript print driver for Windows. 

Included Software
The following items are included on the CD-ROM and are required to print PostScript 
documents from Windows. 
PPD files and PostScript plug-in files - The PPD files and PostScript plug-in files 
(which add Fuji Xerox unique features to Microsoft PScript 5.0 print driver) for 
Windows.
Adobe Reader - Software that allows you to view and print PDF files on all major 
computing platforms.
Readme.txt - Describes the precautions that must be followed when using the print 
driver. Be sure to read this before using the print driver. 
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Hardware/Software Requirements
The system requirements for the PostScript print driver for Windows are as follows:

Supported Hardware
A personal computer on which one of the following operating systems is installed.

Supported Operating Systems
• Windows 2000 Professional

• Windows 2000 Server

• Windows 2000 Advanced Server

• Windows XP Professional Edition

• Windows XP Professional x64 Edition

• Windows XP Home Edition

• Windows Server 2003

• Windows Server 2003 x64 Edition

• Windows Vista

• Windows Vista x64 Edition
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Installing the Print Driver 

This section describes how to install the print driver on Windows 2000, Windows XP, 
Windows Server 2003, or Windows Vista. 
NOTE: To cancel the installation process, click [Cancel] in any dialog box displayed 
during the installation. To cancel the settings in a dialog box and return to the previous 
dialog box on Windows 2000, Windows XP, or Windows Server 2003, click the [Back] 
button; on Windows Vista, click the  icon.

Installation Procedure - Windows 2000/Windows XP/Windows Server 2003
The following shows the installation procedure for Windows 2000, Windows XP, and 
Windows 2003. In this manual, Windows XP is used as an example.
NOTE: The appearance of the installation wizard may differ slightly on Windows 2000 
or Windows Server 2003. 

1. Start Windows XP.

NOTE: When installing the print driver, you must be logged on as a Power User 
group member or as an Administrator. Refer to the Windows XP documentation 
for information about the Power User group.

2. From the [Start] menu, select [Printers and Faxes].

3. In the [Printers and Faxes] window, double-click [Add Printer].

4. Click [Next].
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5. If the printer is directly connected to your computer or over a network in a TCP/IP 
(LPD) environment, select [Local printer attached to this computer]. Otherwise, 
select [A network printer, or a printer attached to another computer]. 
After selecting the connection method, click [Next]. 
In this example, [Local printer attached to this computer] is selected.
NOTE: When [Local printer attached to this computer] is selected, clear the 
[Automatically detect and install my Plug and Play printer] check box. When [A 
network printer, or a printer attached to another computer] is selected, specify the 
printer in the [Specify a Printer] dialog box.

6. Select the port you want to use, and click [Next].
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When the printer is installed in a TCP/IP (LPD) environment:
1) Select [Create a new port].
2) Select [Standard TCP/IP Port] from the [Type of port] list, and click [Next].
3) Click [Next].

4) Enter the IP address of the printer in [Printer Name or IP Address], and click 
[Next].

 

Click [Finish] in the displayed dialog box.

7. Insert the PostScript Driver Library CD-ROM into your CD-ROM drive. 



Installation and Configuration on Windows

14

8. Click [Have Disk].

 

9. In the [Copy manufacturer’s files from] box, enter the path to the print driver folder. 
For 32-bit editions of Windows, enter the drive in which the CD-ROM is located 
(example: "E:") and then  “\English\Win2k_Vista\DocuPrint_C2255”.
For 64-bit editions of Windows, enter the drive in which the CD-ROM is located 
(example: "E:") and then  “\English\WinX64\DocuPrint_C2255”. 
After entering the path, click [OK]. 
NOTE: You can also specify the path by clicking the [Browse] button and 
navigating to the print driver folder.
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10. Click [Next].

 

11. Enter a name for your printer, specify whether to use the printer as the default 
printer, and then click [Next].
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12. Select [Do not share this printer], and click [Next].

 

13. Specify whether to print a test page, and click [Next].
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14. Click [Finish].

 

NOTE: If a message "The software you are installing has not passed Windows 
Logo testing to verify its compatibility with Windows XP" appears, click [Continue 
Anyway] to continue the installation.

The installation begins.

15. Verify that the printer is added to the [Printers and Faxes] window.

 

This completes the installation of the print driver. Remove the CD-ROM from the CD-
ROM drive.
To configure the print driver, see "Configuring the Print Driver" (P. 23). 
Store the CD-ROM in a safe place.
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Installation Procedure - Windows Vista 
The following shows the installation procedure for Windows Vista.

1. Start Windows Vista.

NOTE: Make sure that you are logged on as an Administrator.

2. From the Start menu, select [Control Panel] and then [Hardware and Sound].

3. Under [Printers], select [Add a printer].

4. If the printer is directly connected to your computer or over a network in a TCP/IP 
(LPD) environment, select [Add a local printer]. Otherwise, select [Add a network, 
wireless or Bluetooth printer]. 
After selecting the connection method, click [Next]. 
In this example, we will select [Add a local printer].



Installation and Configuration on Windows

19

5. Select the port you want to use, and click [Next].

When the printer is installed in a TCP/IP(LPD) environment:
1) Select [Create a new port].
2) Select [Standard TCP/IP Port] from the [Type of port] list, and click [Next].
3) Enter the printer’s IP address in [Hostname or IP address], and click [Next].

 

6. Insert the PostScript Driver Library CD-ROM into your CD-ROM drive. 
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7. Click [Have Disk].

 

8. In the [Copy manufacturer’s files from] box, enter the path to the print driver folder. 
For 32-bit editions of Windows, enter the drive in which the CD-ROM is located 
(example: "E:") and then  “\English\Win2k_Vista\DocuPrint_C2255”.
For 64-bit editions of Windows, enter the drive in which the CD-ROM is located 
(example: "E:") and then  “\English\WinX64\DocuPrint_C2255”. 
After entering the path, click [OK].
NOTE: You can also specify the path by clicking the [Browse] button and 
navigating to the print driver folder.
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9. Click [Next].

 

10. Enter a name for your printer, specify whether to use the printer as the default 
printer, and then click [Next].
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11. Specify whether to print a test page, and click [Finish].

 

The installation begins.
NOTE: If the [User Account Control] dialog box appears, click [Continue] to 
continue the installation. If you receive a message "Windows can’t verify the 
publisher of this driver software", click [Install this driver software anyway].

12. Verify that the printer is added to [Control Panel] > [Hardware and Sound] > 
[Printers].

 

This completes the installation of the print driver. Remove the CD-ROM from the CD-
ROM drive.
To configure the print driver, see "Configuring the Print Driver" (P. 23). 
Store the CD-ROM in a safe place.
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Configuring the Print Driver

This section describes the printer-specific features in the following tabs in the print 
driver properties.

• [Device Settings] tab

• [Configuration] tab

• [Advanced] tab

• [Paper / Output] tab

• [Image Options] tab

• [Layout] tab
NOTE: For information about the tabs and features that are not described in this 
section, refer to the online help provided for the print driver.

Windows 2000/Windows XP/Windows Server 2003
To view the [Device Settings] or [Configuration] tab, select the printer icon in the 
[Printers] (Windows 2000) or [Printers and Faxes] (Windows XP/Windows Server 
2003) window, and select [Properties] from the [File] menu.
To view the [Advanced], [Paper / Output], [Image Options], or [Layout] tab, select the 
printer icon in the [Printers] or [Printers and Faxes] window, and select [Printing 
Preferences] from the [File] menu.
You can also access each tab by right-clicking the printer icon and selecting 
[Properties] or [Printing Preferences] in the displayed menu.

Windows Vista
To view the [Device Settings] or [Configuration] tab, select the printer icon in [Control 
panel] > [Hardware and Sound] > [Printers], and select [Set printer properties] from the 
menu displayed at the top of the window.
To view the [Advanced], [Paper / Output], [Image Options], or [Layout] tab, select the 
printer icon in [Control Panel] > [Hardware and Sound] > [Printers], and select [Select 
printing preferences] from the menu displayed at the top of the window.
You can also access each tab by right-clicking the printer icon and selecting 
[Properties] or [Printing Preferences] in the displayed menu.
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[Device Settings] Tab
The following explains the [Installable Options] section on the [Device Settings] tab. To 
print properly, make sure to correctly configure [Installable Options].
Select an item you want to configure from [Installable Options], and select its option 
from the menu that appears on the right.

Setting Items
Paper Tray Configuration - Sets the paper tray configuration of the printer.
Duplex Unit - Sets whether or not the Duplex Unit is installed on the printer.
Hard Disk - Sets whether or not the hard disk is installed on the printer.
Paper Size Settings - Sets the paper size series.
Switch Paper Size (8K/16K) - Sets the sizes of 8K and 16K paper available in your 
region. If you select [Traditional Chinese], the sizes of 8K and 16K paper will be 267 x 
388 mm and 194 x 267 mm respectively. If you select [Simplified Chinese], the sizes 
will be 270 x 390 mm and 195 x 270 mm respectively.
Minimum Passcode Length - Sets the minimum number of digits required for the 
passcode of [Billing ID] and [Secure Print].
Customize User Prompts - Sets the type of ID to be used for authentication. Select 
[Display User ID and Account ID Prompts] to enable both [User ID] and [Account ID] to 
be available for entry. If either [Display User ID Prompt Only] or [Display Account ID 
Prompt Only] is selected, the ID that is not selected will be dimmed out. If [No need to 
enter], [Prompt User for Entry when Submitting Job] in the [User Details Setup] dialog 
box, and [User ID/Account ID] for [User Prompt] in the [Configuration] tab are selected, 
jobs will be sent without a pop-up dialog box. 
Memory - Sets the memory capacity of the printer. 
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Color Mode - Selecting [Black and White only] sets the [Output Color] feature on the 
[Paper / Output] tab to [Black and White] and disables the [Color] option. 
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[Configuration] Tab
The following explains how to configure the [Configuration] tab.
 

Setting Items
Enable Account Setup - Selecting the check box uses the printer’s Authentication 
feature.
Account Mode - Sets whether to allow all users or only the System Administrators to 
change the authentication settings. If [Administrator] is selected, only the System 
Administrators can change the authentication settings in the [User Details Setup] dialog 
box; general users cannot change those settings.
NOTE: If the user who is logged onto the computer does not have access rights to the 
printer settings, [Account Mode] is grayed out and cannot be changed. When the 
[High Speed Printing] check box is selected, [Account Mode] is set to [Administrator] 
and is grayed out. Clearing the check box allows you to change the [Account Mode] 
setting.

User Prompt - Specifies the type of ID information used for authentication.
If [All] is selected, the [User ID], [Account ID], and [Billing ID] boxes will become 
available on the [User Details Setup] and [Enter User Details] dialog boxes.
If [User ID/Account ID] is selected, the [User ID] and [Account ID] boxes will become 
available. If [Billing ID Only] is selected, only the [Billing ID] box will become available.
This feature is not available if [Enable Account Setup] check box is not selected. 
In conjunction with the [Customize User Prompts] setting in the [Device Settings] tab, 
this feature allows you to restrict the type of authentication information that a user can 
enter. 
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User Details Setup - Displays the [User Details Setup] dialog box.
Always Use Default User Details - Sets whether or not to use the authentication 
settings in this dialog box every time you request a print job.

-  User ID Options - Sets the method of specifying a user ID. 
-  User ID - Allows you to enter a user ID with up to 32 alphanumeric characters.

NOTE: When the Authentication feature is enabled on the printer, the [User ID] 
must be the same as that registered on the printer. Otherwise, your job will not be 
printed. If the Authentication feature is not enabled, your job will be printed 
regardless of the [User ID] setting.

-  Passcode (next to [User ID]) - Sets the passcode for the user ID using 4 to 12 
alphanumeric characters. The passcode is optional.

-  Account ID - Allows you to enter an account ID with up to 32 alphanumeric 
characters.

-  Billing ID - Allows you to enter a billing ID for Charge Print with up to 8 
alphanumeric characters.

-  Passcode (next to [Billing ID]) - Sets the passcode for the billing ID with up 
to 12 alphanumeric characters. The passcode is optional.

Prompt User for Entry When Submitting Job - Selecting this radio button displays 
the [Enter User Details] dialog box every time you request a print job. Your job will 
be printed if you enter the ID and passcode (if one is set up) into the dialog box.
NOTE: When the [High Speed Printing] check box is selected, [Prompt User for 
Entry When Submitting Job] is grayed out and cannot be changed.

-  Display Last Entered User Details - Selecting the check box saves the details 
of ID information entered in the [Enter User Details] dialog box and displays 
them as the defaults the next time you display the dialog box. 

-  Mask User ID (***) - Selecting the check box hides the user ID behind asterisks.
-  Mask Account ID (***) - Selecting the check box hides the account ID behind 

asterisks.
High Speed Printing - Increases the print speed of applications that directly create 
PostScript files. Enabling this feature disables some of other features. We advise you 
not use this feature for regular print jobs.
Get Information from Printer - If the printer is networked using TCP/IP or IPX, clicking 
[Get Information from Printer] updates the [Installable Options] section on the [Device 
Settings] tab. Clicking the button also obtains the printer’s address and displays it in 
[Network Address]. 
When your printer is a local printer, the [Get Information from Printer] feature is not 
available, and you must manually set the information on the print driver. To use this 
feature, enable the SNMP port on the printer.
Defaults - Restores the settings on this tab to the defaults.
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[Advanced] Tab
The following explains how to configure the printer-specific features on the [Advanced] 
tab in the Printing Preferences dialog box.
Select an item you want to configure, and select its option from the menu that appears 
on the right. 
 

Setting Items
Covers/Separators

Add Front Cover - Sets the paper tray for front covers. 
Print on Front Cover - Sets whether or not to print on front covers. Selecting [Blank 
Front Cover] does not print data on front cover sheets. Selecting [Printed Front 
Cover] prints data on front cover sheets.
Add Back Cover - Sets the paper tray for back covers. 
Insert Separators - Sets whether or not to insert separators between printed 
sheets, and the paper tray for the separators. Specify the page numbers to insert 
separators in the [Specify Locations] dialog box. Separators will be inserted before 
the specified pages. Up to 20 positions can be entered. Use commas to separate 
multiple entries (e.g. 3,6,10).
Paper Type for Bypass Tray - Sets the paper type for the Bypass Tray when [Tray 
(Bypass)] has been selected for [Add Front Cover], [Add Back Cover] or [Insert 
Separators].
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Transparency Separators
Separator Tray - Sets the paper tray for separators when using the Transparency 
Separators feature. Selecting [Auto Paper Select] uses the paper tray selected on 
the printer. 
Separator Options - Sets whether or not to print on separators. Selecting [Blank 
Separators] inserts blank separators. Selecting [Printed Separators] prints the same 
contents printed on transparencies to separators.
Paper Type for Bypass Tray - Sets the paper type for the Bypass Tray when [Tray 
5 (Bypass)] has been selected for [Separator Tray].

Images
Image Enhancement - Sets whether or not to use the Image Enhancement feature. 
Selecting [On] artificially enhances resolution by smoothing out the edges of 
images. Images (bitmaps) that consist of rough dots may not be reproduced with 
smooth gradations. In such case, set this feature to [Off]. Selecting [On] or [Off] does 
not affect print speed.
Gray Guaranteed - Prints achromatic colors in black. This setting does not apply to 
images. 
Invalidate Color Profile - Sets whether or not to invalidate color profiles. Selecting 
[On] invalidates color profiles.

Advanced Features 
Image Rotation 180 Degrees - Selecting the check box rotates the landscape or 
portrait pages in your document by 180 degrees. When [Multiple-Up] on the [Layout] 
tab is set to an option other than [1 Page Up], this rotates all pages by 180 degrees.
Print in Reverse Order - Selecting [On] prints your document in reverse order.
NOTE: [Print in Reverse Order] is available when [Enable advanced printing 
features] is selected under the [Advanced] tab in the Properties dialog box. 
Disabling [EMF Spooling] on the [Advanced] tab in the Printing Preferences dialog 
box automatically sets [Print in Reverse Order] to [Off]. 

Skip Blank Pages - Sets whether or not to skip blank pages during printing.
Draft Mode - Selecting [On] uses less toner and thus the colors become lighter. Use 
this feature to save toner when printing documents that do not require high image 
quality.
Banner Sheet - Sets whether to print a banner sheet for a print job.
When [Printer Default] is selected, the settings configured on the printer is used.
When [Print Start Page] is selected, the data of a print job is printed following a 
banner sheet.
Separators - Sets whether to insert separators between uncollated print sets, and 
the paper tray for separators.
Notify Job Completion by E-mail - Sets whether you want to be notified by e-mail 
when your print job ends. If [On] is selected, a dialog box appears where you can 
enter an e-mail address. To enable this feature, you also need to configure the 
settings at the printer. For details, refer to the User Guide of the printer.
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Enter E-mail Address - Specifies the e-mail address for the e-mail notification 
feature.

Substitute Tray - Sets what action to take when the paper of the size you requested 
is not loaded in the printer.

-  Printer Default - Uses the settings configured on the printer. 
-  Display Message - Displays a message on the control panel that prompts you 

to load paper. Your document will not be printed until you load paper into the 
printer.

-  Use Closest Size (Reduce to Fit) - Uses paper of the nearest size and prints 
the document at 100% magnification or at a reduced magnification if 
necessary. 

-  Use Closest Size (100%) - Uses paper of the nearest size and prints the 
document at 100% magnification.

-  Use Larger Size (Reduce to Fit) - Uses paper of a larger size and prints the 
document at 100% magnification or at a reduced magnification if necessary. 

-  Use Larger Size (100%) - Uses paper of a larger size and prints the document 
at 100% magnification.

-  Select Tray 5 (Bypass) - Uses Tray 5 (Bypass).
Custom Paper Auto Orientation - If printing on custom paper, selecting [On] 
corrects the orientation of the paper. If your document was printed 90 degrees 
rotated on the paper, set this feature to [On].
Print Mixed Sized Originals - Sets whether to change, if necessary, the orientation 
of images that are to be placed on the back side of paper. This setting is effective 
when mixed sized originals are printed using the 2 Sided Print feature.
EMF Spooling - Sets the spooling format of your print data. Selecting [Available] 
spools the print data in EMF (Enhanced Meta File) format, which minimizes the 
processing time. Selecting [Not Available] spools the print data in RAW format, 
which increases the processing time as the data conversion takes time. If you 
experience any problem by setting this feature to [Available], set it to [Not Available]. 
NOTE: [EMF Spooling] is available only on Windows 2000/XP/Windows Vista, and 
appears when [Enable advanced printing feature] is selected under the [Advanced] 
tab in the Properties dialog box. Enabling [Print in Reverse Order] automatically 
sets [EMF Spooling] to [Available]. 
Use Document Monitor - Sets whether to use Document Monitor. 
NOTE: The 64-bit editions of Windows do not support this feature. 
Modify Dash/Dot Lines of Output - Dash or dotted lines on Microsoft Excel can 
sometimes get printed as solid lines. This feature prevents this problem and prints 
dashed or dotted lines as they are.
Specify paper type for selected tray - Sets whether to enable the [Paper Type] 
setting configured on the [Paper / Output] tab when the [Paper Tray] setting on the 
[Paper / Output] tab is set to Tray 1, 2, 3, or 4.
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[Paper / Output] Tab
The following explains how to configure the [Paper / Output] tab in the Printing 
Preferences dialog box.
 

Setting Items
Job Type - Sets the type of your print job to [Normal Print], [Secure Print], [Sample Set], 
or [Delayed Print].

Normal Print - Prints a job without using the Secure Print, Sample Set, or Delayed 
Print feature.
Secure Print - Temporarily stores a print job in the printer, rather than printing it 
immediately, until you manually start the printing from the control panel.
Sample Set - Allows you to print a proof copy of a multi-set job and prints the entire 
sets once the print result has been verified. 
Delayed Print - Temporarily stores a print job in the printer and prints the data at a 
specified time.
NOTE: To select [Secure Print], [Sample Set], or [Delayed Print],  the [Device 
Settings] tab > [Installable Options] > [Hard Disk] must be set to [Installed].

Setup - This button becomes active when [Job Type] is set to [Secure Print], [Sample 
Set], or [Delayed Print]. Clicking the button displays the [Secure Print], [Sample Set] or 
[Delayed Print] dialog box. 

User ID - Sets the user ID for the Secure Print or Sample Set feature with up to 8 
alphanumeric characters.
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NOTE: [User ID] appears in the [Secure Print] and [Sample Set] dialog boxes.

Secure Print Passcode - Sets the passcode associated with the user ID for the 
Secure Print feature. The passcode can be a 1 to 12 digit number. Asterisks (***) 
appear instead of text as you enter the passcode into this text box.
NOTE: [Secure Print Passcode] appears only in the [Secure Print] dialog box.

Start Print Time - Sets when to print the Delayed Print job. Click the hour or minute 
area, and press the up or down triangle to specify the start time. Alternatively, you 
can enter the time directly into the box. The default setting is 00:00.
NOTE: [Start Print Time] appears only in the [Delayed Print] dialog box.

Document Name - Sets the method of naming a document that will be stored in the 
printer using the Secure Print, Sample Set, or Delayed Print feature. [Use Existing 
Name] automatically retrieves the document name from the application from which 
the document will be printed. If the name exceeds 12 alphanumeric characters, only 
the first 12 characters will be valid.
New Document Name - When [Document Name] is set to [Enter Document Name], 
enter the document name using up to 12 alphanumeric characters.

2 Sided Print - Sets whether to print on both sides of paper.
NOTE: To enable [2 Sided Print],  the [Device Settings] tab > [Installable Options] > 
[Duplex Unit] must be set to [Installed].

Output Color - Sets whether to print in color or in monochrome. [Color] uses all CMYK 
(cyan/magenta/yellow/black) toner when printing. [Black and White] uses only the K 
(black) toner. 
Paper Size - Sets the paper size of your document.
Edit - This button becomes active when [Paper Size] is set to [PostScript Custom Size]. 
Clicking the button displays the [PostScript Custom Size Settings] dialog box where 
you can set a custom paper size. 
Paper Tray - Sets the paper tray to be used for printing the document. 
Feed Orientation for Bypass Tray - Sets the orientation of paper when printing from 
the Bypass Tray. When loading the paper with one of the short edges facing into the 
Bypass Tray, select [Portrait]. When loading the paper with one of the long edges 
facing into the Bypass Tray, select [Landscape]. If the orientation can only be one way 
or the other depending on the paper size, the actual orientation of the paper overrides 
this setting.
Paper Type - Sets the type of paper to be used for printing your document. 
Paper Color - Sets the color of paper to be used for printing your document. 
Saved Settings - Allows you to save customized settings and call them with one quick 
action.
To save customized settings, set the desired features, click [Save], enter a [Job Setting 
Name], and click [OK]. A Job Setting Name can be up to 32 characters long.
To call saved customized settings, click [Load], select the set of settings you want to 
call from [Job Setting Name], and then click [OK]. 
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To delete saved customized settings, click [Save] or [Load], select the set of settings 
you want to delete from [Job Setting Name], click [Delete], and then click [OK].
Status - Displays the [Search Printer] dialog box where you can search for the printer 
to obtain the printer information. 
Defaults - Restores all the settings to the defaults.
Default All - Restores all the settings under Printing Preferences to the defaults, except 
for the ID and passcode settings for the Secure Print feature, the ID setting for the 
Sample Set feature, and the settings for the Notify Job Completion by E-mails feature.
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[Image Options] Tab
The following explains how to configure the [Image Options] tab in the Printing 
Preferences dialog box.
 

Setting Items
Image Quality - Sets the print mode. 

High Speed - This option is for quick output.
High Quality - This option is for high quality output regardless of the speed.
High Resolution - This option is for printing in Decomposer resolution.

Brightness - Sets the overall brightness of the output.
Basic Features - Allows you to configure the basic RGB color correction setting.
NOTE: [Basic Features] is grayed out and cannot be selected when the [Output Color] 
feature on the [Paper / Output] tab is set to [Black and White].

Advanced Features - Allows you to configure the advanced RGB color correction 
settings.
NOTE: [Advanced Features] is grayed out and cannot be selected when the [Output 
Color] feature on the [Paper / Output] tab is set to [Black and White].

Image Adjustment - Displays the [Image Adjustment] dialog box where you can 
configure RGB and CMYK color correction settings. Only [RGB Gamma Correction] is 
available if you selected the [Basic Features] radio button. 
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NOTE: The [Image Adjustment] button is inactive and cannot be selected when the 
[Output Color] feature on the [Paper / Output] tab is [Black and White].

RGB Color Correction - Sets the color correction method for the RGB images on 
your document. 

-  Perceptual - Optimizes the rendering of photographic images by preserving all 
tonal gradations.

-  Saturation - Optimizes the rendering of business graphics by preserving the 
saturation of colors.

-  Relative Colorimetric - Preserves in-gamut colors and represents out-of-
gamut colors by the closest match.

-  Absolute Colorimetric - Does not map the white in images to the white of the 
output paper. Depending on the [RGB Color Temperature] setting, the white in 
images may be printed with a tint of color.

Source RGB Profile - Sets an RGB profile. The [Source RGB Profile] setting will be 
applied in conjunction with the [RGB Color Correction] setting. [Adobe RGB (1998)] 
is the RGB profile of Adobe Systems Incorporated. [Adobe RGB (1998)] may not 
accurately reproduce the tones of highly saturated graphics.
RGB Gamma Correction - Adjusts the brightness of the RGB images on your 
document. Select a value depending on the monitor being used. The larger the 
value, the darker the output. 
RGB Color Temperature - Adjusts the color temperature of your monitor to match 
the on-screen colors to the printed output colors.

-  5000K (D50) - Colors become slightly more yellowish than [6500K (D65)].
-  6500K (D65)
-  9300K - Colors become slightly more bluish than [6500K (D65)].

CMYK Color Correction - Sets the color correction method for the CMYK images 
on your document.

-  Auto Correction - Selects the color correction method commonly used in your 
region.

-  Japan Color 2001 - Selects Japan Color 2001 as the color correction method.
-  SWOP - Selects SWOP as the color correction method.
-  Euro Sheet-fed - Selects Euro Sheet-fed as the color correction method.
-  No Correction - Disables this feature.

Target Paper - Sets the type of paper for CMYK color correction. This is not the 
paper for printing. 

-  Auto - Selects the type of target paper commonly used in your region.
-  Art - Selects Art as the target paper type.
-  Coated - Selects Coated as the target paper type.
-  Matt - Selects Matt as the target paper type.

Image Types - Sets the type of your document.
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NOTE: [Image Types] appears only when [Basic Features] is selected. When 
[Advanced Features] is selected, [RGB Color Correction] and [CMYK Color 
Correction] appear instead, which are identical to those in the [Image Adjustment] 
dialog box.

Standard - Optimizes the printing of business documents that consist of text and 
graphs.
Photos - Suitable for printing photographic images and optimizes the reproduction 
of gradations. This is ideal for images represented in sRGB. 
Presentation - Suitable for printing presentation materials that need vibrant colors.
Web Pages - Suitable for printing images displayed on your computer screen, such 
as web pages.
CAD - Suitable for printing images that contain thin lines or small text.
POP - Suitable for printing colorful images.
Off - Does not perform color correction.

Screen - Adjusts the image quality of your document. 
Auto Screening - Automatically adjusts the image quality based on the type of the 
document.
Fineness - Optimizes the reproduction of text and lines.
Standard - Optimizes the reproduction of photographic images.
Gradation - Optimizes the reproduction of charts and graphs.

Color Balance - Displays the [Color Balance] dialog box. 
Adjust Color Balance - Selecting the check box allows you to adjust the density of 
the CMYK (cyan/magenta/yellow/black) toner.
To adjust the density of a color, select the color from [Target Color] and specify its 
density for [Highlights], [Midtones], and [Shadows].
NOTE: You can only adjust the density of [Black] when the [Output Color] feature 
on the [Paper / Output] tab is [Black and White].

Defaults - Restores all the settings to the defaults.
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[Layout] Tab
The following explains how to configure the [Layout] tab in the Printing Preferences 
dialog box.
 

Setting Items
Multiple-Up - Prints multiple pages onto one sheet of paper.
Draw Outlines - Prints a border around each page when using the [Multiple-Up] 
feature.
Fit to New Paper Size - Sets the size of the output paper. This setting is available when 
[Booklet Creation] is set to [No Booklets]. When this setting is different from [Paper 
Size] on the [Paper / Output] tab, your document will be reduced/enlarged to fit to the 
paper size selected here.
Booklet Creation - Sets whether or not to use the Booklet Creation feature. To enable 
this feature, select [Left Bind/Top Bind] or [Right Bind/Bottom Bind].
NOTE: To enable the Booklet Creation feature,  the [Device Settings] tab > [Installable 
Options] > [Duplex Unit] must be set to [Installed].

NOTE: When [Booklet Creation] is selected, only [Auto Paper Select] and [Auto Paper 
Select (Type/Color)] are available in [Paper Tray] on the [Paper / Output] tab.  
Conversely, the [Booklet Creation] feature is only available when [Auto Paper Select] 
or [Auto Paper Select (Type/Color)] is selected in [Paper Tray]. 

Booklet Output Size - Sets the output size for the booklet.
Divide Output - Divides the booklet into the specified number of subsets.
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Binding Edge Erase - Adds a binding margin to the center of paper so that images will 
not be lost when the paper is bound.
Auto-fit - Automatically reduces print images to fit onto the narrower print area caused 
by the addition of the Binding Edge Erase. 
Margins 0 - 25 mm / 0.0 - 1.0 inch - Sets the width of the margin in the range of 0 to 
5 mm in 1 mm increments, or in the range of 0.0 to 1.0 inch in 0.1 inch increments.
Units - Sets the unit for [Margins].
Image Shift - Displays the [Image Shift] dialog box.

Edge Position - Sets the image shift (binding margin) position. The margin can be 
added to the left, right, top, or bottom of the paper. The position of the margins 
change according to the paper orientation.
Side 1 - Sets the margin on side 1 of the paper when using the Image Shift feature. 
You can specify a value between 0 and 50 mm in 1 mm increments using the 
keyboard or the up and down arrows.
Side 2 - Sets the margin on side 2 of the paper when using the Image Shift feature 
in 2 sided printing. The image shift position for side 2 is automatically set so that the 
margin is added to the same edge as side 1. You can specify a value between 0 and 
50 mm in 1mm increments using the keyboard or the up and down arrows.

Defaults - Restores all the settings to the defaults.



Installation and Configuration on Windows

39

Using the Online Help

The following explains how to use the online help.
 

[?] mark
Clicking the  mark at the top right of the print driver dialog box and then clicking a 
setting item displays the description of the item. You can also display the description 
by right-clicking the item itself.
NOTE: The  mark does not appear on the print driver dialog box for Windows Vista. 
To display the description of an item, right-click the item itself.

[Help] button 
Clicking the [Help] button at the bottom right of the print driver dialog box displays the 
description of the tab that is currently displayed. 
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2 Installation and Configuration on 
Mac OS 

This chapter contains the following information:

• About the CD-ROM
– Included Software
– Hardware/Software Requirements

• Installing the Print Driver
–  Installation Procedure (Mac OS 8.6/9.2.2)
– Configuring the PPD File (Mac OS 8.6/9.2.2)
– Installation Procedure (Max OS X 10.3.9/10.4)
– Adding the Printer (Max OS X 10.3.9/10.4)

• Configuring the Print Driver
– Installable Options (Mac OS 8.6/9.2.2)
– Installable Options (Max OS X 10.3.9/10.4)
– Printer Specific Options (Mac OS 8.6/9.2.2)
– Fuji Xerox Features (Max OS X 10.3.9/10.4)
– Image Options (Max OS X 10.3.9/10.4)
– Job Accounting (Max OS X 10.3.9/10.4)
– Job Type (Max OS X 10.3.9/10.4)
– Watermark (Max OS X 10.3.9/10.4)

• Installing the Screen Fonts

About the CD-ROM

This section describes the contents of the PostScript Driver Library CD-ROM and the 
system requirements for using the PostScript print driver for Mac OS.

Included Software
The following items are included on the CD-ROM and are required to print PostScript 
documents from Mac OS. 
AdobePS 8.8 and PPD files - The Adobe PostScript print driver for Mac OS 8.6/9.2.2 
and the PPD (PostScript Printer Description) files for Mac OS.
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Fuji Xerox Plug-in Installer - The PPD installer for Mac OS X 10.3.9 and 10.4.
Adobe Screen Fonts - Contains screen fonts (17 TrueType fonts and 117 PostScript 
fonts) that are standard for PostScript 3 printers. It also contains 37 PostScript fonts for 
the Central European (CE) character codes.
Adobe Reader - Software that allows you to view and print PDF files on all major 
computing platforms.
Readme.txt - Describes the precautions that must be followed when using the print 
driver. Be sure to read this before using the print driver.

Hardware/Software Requirements
The system requirements for the print driver for Mac OS are as follows:

Supported Hardware
• Macintosh

• Power Macintosh

• Intel CPU-based Macintosh

Supported Operating Systems
• Mac OS 8.6

• Mac OS 9.2.2

• Mac OS X 10.3.9

• Mac OS X 10.4

Print Driver
• AdobePS 8.8  - Mac OS 8.6/9.2.2

Plug-in Installer
• Fuji Xerox Plug-in Installer - Mac OS X 10.3.9/10.4

Installing the Print Driver

This section describes how to install an AdobePS print driver on Mac OS 8.6/9.2.2 and 
how to add the printer on Mac OS X 10.3.9/10.4.
NOTE: You do not need to install a PostScript print driver on Mac OS X. A PostScript 
print driver is already installed as a part of Mac OS X.
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Installation Procedure (Mac OS 8.6/9.2.2)
The following explains how to install an AdobePS print driver on Mac OS 8.6/9.2.2.

1. Start Mac OS 8.6/9.2.2.

2. Insert the PostScript Driver Library CD-ROM into your CD-ROM drive. 
The [FXOPS-PS] icon appears on your desktop.

3. Double-click the [FXOPS-PS] icon. 
The [FXOPS-PS] window appears.

4. Double-click the folder for your printer model and then the "AdobePS880" folder. 

5. Double-click [AdobePS Installer 8.8].
The installer launches.

6. Click [Continue...]. 

7. Read the license agreement. If you agree, click [Accept]. 

Read "Read Me", and click [Continue].
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8. Verify [Install Location], change it if necessary, and click [Install].

The installation begins.
When the installation is complete, the following dialog box appears.

9. Click [Continue] or [Quit]. 

This completes the installation of the print driver.
Proceed to Configuring the PPD File (Mac OS 8.6/9.2.2) on page 44 to configure the 
PPD file on the print driver.

Configuring the PPD File (Mac OS 8.6/9.2.2)
When you are finished installing the AdobePS print driver, configure the PostScript 
Printer Description (PPD) file onto the print driver.
The print driver controls the printer’s features based on the information stored in the 
PPD file.

When Using EtherTalk

1. Make sure that the printer is switched on.

2. Make sure that the printer’s EtherTalk port is set to [Enabled].

NOTE: See the User Guide on how to enable the EtherTalk port. 

3. From the [Apple] menu, select [Chooser], and then click [AdobePS].

4. In the [Chooser] dialog box, select the printer from the [Select a PostScript Printer] 
list box, and then click [Create].
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NOTE: The displayed window may vary depending on the connection 
environment of the printer and a host device.

The printer is searched automatically and the PPD file is configured.
If the PPD File was Not Found Automatically:
(1) The [Select a PostScriptTM Printer Description File] dialog box appears.
(2) Select the PPD file for your printer model, and click [Select]. 

The PPD file is configured.

5. In the [Chooser] dialog box, select [Create] to set the options installed on the 
printer.
NOTE: You can change the option settings even after the installation of the print 
driver.
To use the features of the options, you must set [Installable Options]. Normally, 
[Installable Options] is set automatically via bi-directional communication with the 
printer, and you do not need to change the settings. 
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6. Click [Configure].

7. Set the options installed on the printer.

For information on how to set the options, see Configuring the Print Driver on page 
56.

8. Click [OK]. 
Click [OK] again in the next window.

9. Close [Chooser].

When Using the USB Port

1. When a USB cable is connected to your printer, disconnect it.

2. Make sure that your computer is switched on, and then switch the printer off.

3. Connect your computer and the printer with a USB cable.

4. Switch the printer on.

5. Double-click [Desktop Printer Utility].
[Desktop Printer Utility] launches and the [New Desktop Printer] dialog box 
appears.
NOTE: [Desktop Printer Utility] is stored in the "AdobePS Components" folder in 
your Macintosh hard disk.
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6. From [With], select [AdobePS]. 
From [Create Desktop...], select [Printer (USB)]. 
Click [OK].

7. In [USB Printer Selection], click [Change...]. 
The [USB Printer] dialog box appears.

8. Select your printer from [Select a USB Printer], and click [OK].
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9. In [PostScriptTM Printer Description (PPD) File], click [Auto Setup]. 
The [Select a PostScriptTM Printer Description File] dialog box appears.

10. Select the PPD file for your printer model, and click [Select].

The PPD file is configured.

11. Click [Create...].

12. A dialog box asking if you want to save the changes appears. Click [Save] in the 
dialog box.
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13. In the displayed dialog box, specify the printer’s name and installation location, 
and click [Save]. 
Your settings are saved and the printer is created.

14. Set the options installed on the printer.

NOTE: You can change the option settings even after the installation of the print 
driver.
To use the features of the options, you must set [Installable Options]. Normally, 
[Installable Options] is set automatically via bi-directional communication with the 
printer and you do not need to change the settings. 

Installation Procedure (Mac OS X 10.3.9/10.4)
This section describes how to install the PPD file on Mac OS X 10.3.9, or Mac OS X 
10.4.
To install a PPD file on Mac OS X 10.3.9 and Mac OS X 10.4, use Fuji Xerox Plug-in 
Installer.
NOTE: You do not need to install a PostScript print driver on Mac OS X. A PostScript 
driver is already included as a part of Mac OS X.

The following procedure uses Mac OS X 10.3.9 as an example.

1. Insert the PostScript Driver Library CD-ROM into your CD-ROM drive.

The [FXOPS-PS] icon appears on your desktop.

2. Double-click the [FXOPS-PS] icon.

The [FXOPS-PS] window appears.

3. Double-click the folder for your printer and then the folder for your Mac OS X. 

4. Double-click the [Fuji Xerox Plug-in Installer] program icon.

The installer launches, and the [Authenticate] window appears.

5. Enter the administrator’s user name and password, and then click [OK].

The license agreement appears.

6. Read the license agreement, and click [Continue].
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7. If you agree to the terms of the license agreement, click [Agree].

8. Click [Install].

9. A dialog box that informs you that the installation is complete appears. Click [Quit] 
in the dialog box.

This completes the installation of the PPD file.
Proceed to Adding the Printer (Mac OS X 10.3.9/10.4) on page 51 to configure the PPD 
file on your print driver.
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Adding the Printer  (Mac OS X 10.3.9/10.4)
When you are finished installing the PPD file, configure it on your print driver, and add 
the printer to the [Printer List] window. 
The print driver controls the printer’s features based on the information stored in the 
PPD file.

1. If using the USB port, perform the following. 
If not using the USB port, proceed to Step 2.
1) If a USB cable is connected to your printer, disconnect it.
2) Make sure that your computer is switched on, and switch the printer off.
3) Connect your computer and the printer with a USB cable.
4) Switch the printer on.

2. Check the printer’s port status. 
When using IP Printing, set the LPD port to [Enabled].
When using AppleTalk, set the AppleTalk port to [Enabled].
When using USB, set the USB port to [Enabled].
When using Rendezvous (Bonjour), set the Bonjour port to [Enabled].
NOTE: Refer to the User Guide on how to enable each port.

3. Start [Printer Setup Utility]. 

NOTE: [Printer Setup Utility] is in the "Utilities" folder under the "Applications" 
folder. 

The [Printer List] window appears.

4. Click [Add].

5. Select the protocol you want to use to connect to the printer.

For Mac OS X 10.3.9, proceed to Procedure - Mac OS X 10.3.9 on page 51.
For Mac OS X 10.4, proceed to Procedure - Mac OS X 10.4 on page 54.

Procedure - Mac OS X 10.3.9

When Using AppleTalk 

1. Select [AppleTalk] from the pull-down menu at the top of the dialog box, and 
specify the zone where the printer is located.
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2. Select the printer from the list.

3. From [Printer Model], select [Auto Select], and proceed to Step 6.
If the PPD file for your printer was not found automatically, select [Other...] and 
proceed to Step 4.
The [Choose a File] dialog box appears.

4. Display "/Library/Printers/PPDs/Contents/Resources/en.lpoj".

5. Select the PPD file for your printer, and click [Choose]. 

6. Click [Add].

When Using IP Printing

1. Select [IP Printing] from the pull-down menu at the top of the dialog box, select 
[LPD/LPR] from [Printer Type], and then enter the printer’s IP address in [Printer 
Address].

2. From [Printer Model], select [FX]. 
From [Model Name], select the PPD file for your printer model.

3. Click [Add].
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When Using USB

1. Select [USB] from the pull-down menu at the top of the dialog box, and select the 
printer from the list.

2. From [Printer Model], select [FX]. 
From [Model Name], select the PPD file for your printer.

3. Click [Add].

When Using Rendezvous (Bonjour)

1. Select [Rendezvous] from the pull-down menu at the top of the dialog box, and 
select the printer from [Name].

2. From [Printer Model], select [FX]. 
From [Model Name], select the PPD file for your printer.

3. Click [Add].
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Procedure - Mac OS X 10.4

When Using AppleTalk, USB, or Bonjour
NOTE: If you switch on the printer after connecting a USB cable, the printer will be 
added automatically to the [Printer List] window. In such case, delete the printer and 
add it manually using the following procedure.

1. In the [Printer Browser] window, select [Default Browser].
The printers available on the AppleTalk, USB, and Bonjour ports are displayed.

2. Select the printer you want to use from the list.

3. Verify that the printer is selected in [Print Using].
When the printer is not selected, select [FX] in [Print Using]. From the list of model 
names, select the PPD file for your printer.

4. Click [Add].

5. In the displayed window, set the options installed on the printer, and click 
[Continue].
NOTE: The option settings can be configured also after adding the printer.



Installation and Configuration on Mac OS

55

When Using IP Printing

1. In the [Printer Browser] window, select [IP Printer].

2. From the [Protocol] menu, select [Line Printer Daemon - LPD] and enter the IP 
address of the printer in [Address].

3. Verify that the printer is selected in [Print Using].
When the printer is not selected, select [FX] in [Print Using]. From the list of model 
names, select the PPD file for your printer.

4. Click [Add].

5. In the displayed window, set the options installed on the printer, and click 
[Continue].
NOTE: The option settings can be configured also after adding the printer.

The printer is now added to the [Printer List] window.
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Configuring the Print Driver

This section describes how to configure the [Installable Options], [Printer Specific 
Options], [Fuji Xerox Features], [Image Options], [Job Type], and [Job Accounting] 
dialog boxes on your print driver.

Installable Options (Mac OS 8.6/9.2.2)
The following explains how to configure [Installable Options] on Mac OS 8.6/9.2.2.
NOTE: The screen shots used in this section are those taken on Mac OS 9.2.2. The 
names of the setting items and the appearance of the dialog boxes may differ on Mac 
OS 8.6. 

NOTE: Normally, [Installable Options] is set automatically via bi-directional 
communication with the printer, and you do not need to change the settings.

1. Select the printer in [Chooser], and click [Setup].

The [Current Printer Description File (PPD) Selected] dialog box appears.

2. Click [Configure].

The [Installable Options] list appears.

3. Configure [Installable Options], and click [OK]. 

Setting Items
Paper Tray Configuration - Sets the paper tray configuration of the printer.
Duplex Unit - Sets whether or not the Duplex Unit is installed on the printer.
Hard Disk - Sets whether or not the hard disk is installed on the printer.
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Paper Size Settings - Sets the paper size series.
Switch Paper Size (8K/16K) - Sets the sizes of 8K and 16K paper available in your 
region. If you select [Traditional Chinese], the sizes of 8K and 16K paper will be 267 x 
388 mm and 194 x 267 mm respectively. If you select [Simplified Chinese], the sizes 
will be 270 x 390 mm and 195 x 270 mm respectively.
Memory - Sets the memory capacity of the printer. 
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Installable Options (Mac OS X 10.3.9/10.4)
The following explains how to configure the [Installable Options] dialog box on Mac OS 
X 10.3.9/10.4.
NOTE: The screen shots used in this section are those taken on Mac OS X 10.3.9. 
The names of the setting items and the appearance of the dialog boxes may differ on 
Mac OS X 10.4. 

1. In the [Printer List] window, select the printer and then [Show Info].

2. Select [Installable Options] from the pull-down menu at the top of the dialog box, 
and set the options installed on the printer.

 

Setting Items
Paper Tray Configuration - Sets the paper tray configuration of the printer.
Duplex Unit - Sets whether or not the Duplex Unit is installed on the printer.
Hard Disk - Sets whether or not the hard disk is installed on the printer.
Paper Size Settings - Sets the paper size series.
Switch Paper Size (8K/16K) - Sets the sizes of 8K and 16K paper available in your 
region. If you select [Traditional Chinese], the sizes of 8K and 16K paper will be 267 x 
388 mm and 194 x 267 mm respectively. If you select [Simplified Chinese], the sizes 
will be 270 x 390 mm and 195 x 270 mm respectively.
Minimum Passcode Length - Sets the minimum number of digits required for the 
passcode of [Billing ID] and [Secure Print].
Customize User Prompts - Sets the type of ID to be used for authentication. Select 
[Display User ID and Account ID Prompts] to enable both [User ID] and [Account ID] to 
be available for entry. If either [Display User ID Prompt Only] or [Display Account ID 
Prompt Only] is selected, the ID that is not selected will be dimmed out. If [No need to 
enter], [Prompt User for Entry when Submitting Job] in the [User Details Setup] dialog 
box, and [User ID/Account ID] for [User Prompt] in the [Job Accounting] dialog box are 
selected, jobs will be sent without a pop-up dialog box. 
Memory - Sets the memory capacity of the printer. 
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 Printer Specific Options (Mac OS 8.6/9.2.2)
The following explains how to configure [Printer Specific Options] on Mac OS 8.6/9.2.2.
NOTE: The screen shots used in this section are those taken on Max OS 9.2.2. The 
names of the setting items and the appearance of the dialog boxes may differ on Mac 
OS 8.6. 

1. On an application, click [Print] from the [File] menu.

The [Print] dialog box appears.

2. Select [Printer Specific Options].

3. Set the desired features.
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Setting Items
The items in [Printer Specific Options] vary depending on the options installed on the 
printer. Make sure to set [Installable Options] before configuring these items. For 
information on [Installable Options], see Installable Options (Mac OS 8.6/9.2.2) on 
page 56.
Paper Type - Sets the type of paper to be used when printing your document. Selecting 
[Printer Default Type] uses the paper type selected on the printer.
Paper Color -  Sets the color of paper to be used when printing your document.
Collated -  Sets whether or not to collate multiple-page documents.
Output Destination -  Sets the output tray.
Add Front Cover - Sets the paper tray for front covers. 
Add Back Cover - Sets the paper tray for back covers. 
Transp. Separators - Sets the paper tray for separators when using the Transparency 
Separators feature. Selecting [Auto Paper Select] uses the paper tray selected on the 
printer. 
Print on Transp. Separators - Sets whether or not to print on separators. Selecting 
[Blank Separators] inserts blank separators. Selecting [Printed Separators] prints the 
same contents printed on transparencies to separators.
Paper Type (Transp. Separators) - Sets the paper type for the Bypass Tray when 
[Tray 5 (Bypass)] has been selected for [Transp. Separators].
Separators - Sets whether or not to insert separators between print sets, and the paper 
tray for the separators.
Booklet Creation - Sets whether or not to use the Booklet Creation feature. To enable 
this feature, select [Left Bind/Top Bind] or [Right Bind/Bottom Bind].
Booklet Output Size - Sets the output size for the booklet.
Booklet Divide Output - Divides the booklet into the specified number of subsets.
Draw outlines option in Booklet - Adds an outline onto each page of the booklet.
Print Mixed Sized Originals -  Sets whether to change, if necessary, the orientation 
of images that are to be placed on the back side of paper. This setting is effective when 
mixed sized originals are printed using the 2 Sided Print feature.
Custom Paper Auto Orientation - If printing on custom paper, this feature corrects the 
orientation of the paper. If your document was printed 90 degrees rotated on the paper, 
select this check box.
Feed Orientation - Sets the orientation of paper when printing from the manual feeder. 
The options of [Portrait] and [Landscape] are available. If the orientation can only be 
one way or the other depending on the paper size, the actual orientation of the paper 
overrides this setting. 
Skip Blank Pages - Sets whether or not to skip blank pages during printing.
Substitute Tray - Sets what action to take when the paper of the size you requested 
is not loaded in the printer.

Printer Default - Uses the settings configured on the printer. 
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Display Message - Displays a message on the control panel that prompts you to 
load paper. Your document will not be printed until you load paper into the printer.
Use Closest Size (Reduce to Fit) - Uses paper of the nearest size and prints the 
document at 100% magnification or at a reduced magnification if necessary. 
Use Closest Size (100%) - Uses paper of the nearest size and prints the document 
at 100% magnification.
Use Larger Size (Reduce to Fit) - Uses paper of a larger size and prints the 
document at 100% magnification or at a reduced magnification if necessary.
Use Larger Size (100%) - Uses paper of a larger size and prints the document at 
100% magnification.
Select Tray 5 (Bypass) - Uses Tray 5 (Bypass).

Specify paper type for selected tray - Sets whether to enable the [Paper Type] 
setting in the [Set 1] dialog box when Tray 1, 2, 3, or 4 is specified.
Output Color - Sets whether to print in color or in monochrome. [Color] uses all CMYK 
(cyan/magenta/yellow/black) toner when printing. [Black and White] uses only the K 
(black) toner.
Gray Guaranteed - Selecting the check box prints achromatic colors in black. This 
does not apply to images.
Invalidate Color Profile - Sets whether or not to invalidate color profiles. Selecting 
[On] invalidates color profiles.
Image Enhancement - Sets whether or not to use the Image Enhancement feature. 
This feature artificially enhances resolution by smoothing out the edges of images. 
Images (bitmaps) that consist of rough dots may not be reproduced with smooth 
gradations. In such case, disable this feature. Enabling or disabling this feature does 
not affect print speed.
Draft Mode - Selecting the check box prints with less toner and thus the colors become 
lighter. Use this feature to save toner when printing documents that do not require high 
image quality.
Image Quality - Sets the print mode.

High Speed - This option is for quick output.
High Quality - This option is for high quality output regardless of the speed.
High Resolution - This option is for printing in Decomposer resolution.

Brightness - Sets the overall brightness of the output.
Image Type - Sets the type of your document.

Standard - Optimizes the printing of business documents that consist of text and 
graphs.
Photos - Suitable for printing photographic images and optimizes the reproduction 
of gradations. This is ideal for images represented in sRGB. 
Presentation - Suitable for printing presentation materials that need vibrant colors.
Web Pages - Suitable for printing images displayed on your computer screen, such 
as web pages.
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CAD - Suitable for printing images that contain thin lines or small text.
POP - Suitable for printing colorful images.
Off - Does not perform color correction.

Screen - Adjusts the image quality of your document. 
Auto Screening - Automatically adjusts the image quality based on the type of the 
document.
Fineness - Optimizes the reproduction of text and lines.
Standard - Optimizes the reproduction of photographic images.
Gradation - Optimizes the reproduction of charts and graphs.

RGB Color Correction - Sets the color correction method for the RGB images on your 
document. 

Perceptual - Optimizes the rendering of photographic images by preserving all tonal 
gradations.
Saturation - Optimizes the rendering of business graphics by preserving the 
saturation of colors.
Relative Colorimetric - Preserves in-gamut colors and represents out-of-gamut 
colors by the closest match.
Absolute Colorimetric - Does not map the white in images to the white of the 
output paper. Depending on the [RGB Color Temperature] setting, the white in 
images may be printed with a tint of color.

Source RGB Profile - Sets an RGB profile. The [Source RGB Profile] setting will be 
applied in conjunction with the [RGB Color Correction] setting. [Adobe RGB (1998)] is 
the RGB profile of Adobe Systems Incorporated. [Adobe RGB (1998)] may not 
accurately reproduce the tones of highly saturated graphics.
RGB Gamma Correction - Adjusts the brightness of the RGB images on your 
document. Select a value depending on the monitor being used. The larger the value, 
the darker the output. 
RGB Color Temperature - Adjusts the color temperature of your monitor to match the 
on-screen colors to the printed output colors.

5000K (D50) - Colors become slightly more yellowish than [6500K (D65)]
6500K (D65) - 
9300K - Colors become slightly more bluish than [6500K (D65)].

CMYK Color Correction - Sets the color correction method for the CMYK images on 
your document.

Auto Correction - Selects the color correction method commonly used in your 
region.
Japan Color 2001 - Selects Japan Color 2001 as the color correction method.
SWOP - Selects SWOP as the color correction method.
Euro Sheet-fed - Selects Euro Sheet-fed as the color correction method.
No Correction - Disables this feature.
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Target Paper - Sets the type of paper for CMYK color correction. This is not the paper 
for printing. 

Auto - Selects the type of target paper commonly used in your region.
Art - Selects Art as the target paper type.
Coated - Selects Coated as the target paper type.
Matt - Selects Matt as the target paper type.
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Fuji Xerox Features (Mac OS X 10.3.9/10.4)
The following explains how to configure the [Fuji Xerox Features] dialog box.
NOTE: The screen shots used in this section are those taken on Mac OS X 10.3.9. 
The names of the setting items and the appearance of the dialog boxes may differ on 
Mac OS X 10.4. 

1. On your application, click [Print] from the [File] menu.

The [Print] dialog box appears.

2. Select [Fuji Xerox Features].

3. Set the desired features.

Setting Items
The items in [Fuji Xerox Features] vary depending on the options installed on the 
printer. Make sure to set [Installable Options] before configuring these items. For 
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information on [Installable Options], see Installable Options (Mac OS 8.6/9.2.2) on 
page 56.

Feature Sets - Set 1
Paper Type - Sets the type of paper to be used when printing your document. Selecting 
[Printer Default Type] uses the paper type selected on the printer.
Output Destination -  Sets the output tray.
Paper Color -  Sets the color of paper to be used when printing your document.
Separators -  Sets whether to insert a separator between uncollated print sets, and the 
paper tray for separators.
Print Mixed Sized Originals -  Sets whether to change, if necessary, the orientation 
of images that are to be placed on the back side of paper. This setting is effective when 
mixed sized originals are printed using the 2 Sided Print feature.
Custom Paper Auto Orientation - If printing on custom paper, this feature corrects the 
orientation of the paper. If your document was printed 90 degrees rotated on the paper, 
select this check box.

Feature Sets - Set 2
Feed Orientation - Sets the orientation of paper when printing from the manual feeder. 
The options of [Portrait] and [Landscape] are available. If the orientation can only be 
one way or the other depending on the paper size, the actual orientation of the paper 
overrides this setting. 
Skip Blank Pages - Sets whether or not to skip blank pages during printing.
Substitute Tray - Sets what action to take when the paper of the size you requested 
is not loaded in the printer.

Printer Default - Uses the settings configured on the printer. 
Display Message - Displays a message on the control panel that prompts you to 
load paper. Your document will not be printed until you load paper into the printer.
Use Closest Size (Reduce to Fit) - Uses paper of the nearest size and prints the 
document at 100% magnification or at a reduced magnification if necessary. 
Use Closest Size (100%) - Uses paper of the nearest size and prints the document 
at 100% magnification.
Use Larger Size (Reduce to Fit) - Uses paper of a larger size and prints the 
document at 100% magnification or at a reduced magnification if necessary.
Use Larger Size (100%) - Uses paper of a larger size and prints the document at 
100% magnification.
Select Tray 5 (Bypass) - Uses Tray 5 (Bypass).

Specify paper type for selected tray - Sets whether to enable the [Paper Type] 
setting in the [Set 1] dialog box when Tray 1, 2, 3, or 4 is specified.
Gray Guaranteed - Selecting the check box prints achromatic colors in black. This 
does not apply to images.
Invalidate Color Profile - Sets whether or not to invalidate color profiles. Selecting this 
check box invalidates color profiles.
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Feature Sets - Set 3
Image Enhancement - Sets whether or not to use the Image Enhancement feature. 
This feature artificially enhances resolution by smoothing out the edges of images. 
Images (bitmaps) that consist of rough dots may not be reproduced with smooth 
gradations. In such case, disable this feature. Enabling or disabling this feature does 
not affect print speed.
Draft Mode - Selecting the check box prints with less toner and thus the colors become 
lighter. Use this feature to save toner when printing documents that do not require high 
image quality.

Covers/Separators
Add Front Cover - Sets the paper tray for front covers. 
Add Back Cover - Sets the paper tray for back covers. 
Separators - Sets whether or not to insert separators between printed sheets, and the 
paper tray for the separators. Specify the page numbers to insert separators in the 
[Specify Locations] dialog box. Separators will be inserted before the specified pages. 
Up to 20 positions can be entered. Use commas to separate multiple entries (e.g. 
3,6,10).
Paper Type (Covers/Separators) - Sets the paper type for the Bypass Tray when 
[Tray 5 (Bypass)] has been selected for [Add Front Cover], [Add Back Cover] or 
[Separators].

Layout
Booklet Creation - Sets whether or not to use the Booklet Creation feature. To enable 
this feature, select [Left Bind/Top Bind] or [Right Bind/Bottom Bind].
Booklet Output Size - Sets the output size for the booklet.
Booklet Divide Output - Divides the booklet into the specified number of subsets.
Draw outlines option in Booklet - Adds an outline onto each page of the booklet.
Binding Edge Erase - Adds a binding margin to the center of paper so that images will 
not be lost when the paper is bound. Selecting this check box activates the [Setup] 
button.
Setup - Allows you to specify a margin value.

Auto Fit - Automatically reduces print images to fit onto the narrower print area 
caused by the addition of the Binding Edge Erase. 
Margins 0 - 25 mm / 0.0 - 1.0 inches - Sets the width of the margin in the range of 
0 to 5 mm in 1 mm increments, or in the range of 0.0 to 1.0 inch in 0.1 inch 
increments.
Millimeters - Sets the unit for [Margins] to millimeters.
Inches - Sets the unit for [Margins] to inches.

Transparency Separators
Transp. Separators - Sets the paper tray for separators when using the Transparency 
Separators feature. Selecting [Auto Paper Select] uses the paper tray selected on the 
printer. 
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Print on Transp. Separators - Sets whether or not to print on separators. Selecting 
[Blank Separators] inserts blank separators. Selecting [Printed Separators] prints the 
same contents printed on transparencies to separators.
Paper Type (Transp. Separators) - Sets the paper type for the Bypass Tray when 
[Tray 5 (Bypass)] has been selected for [Transp. Separators].
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Image Options (Mac OS X 10.3.9/10.4)
The following explains how to configure the [Image Options] dialog box.

1. On your application, click [Print] from the [File] menu.

The [Print] dialog box appears.

2. Select [Image Options].

3. Set the desired features.

Setting Items
Output Color - Sets whether to print in color or in monochrome. [Color] uses all CMYK 
(cyan/magenta/yellow/black) toner when printing. [Black and White] uses only the K 
(black) toner.
Brightness - Sets the overall brightness of the output.
Image Quality - Sets the print mode.

High Speed - This option is for quick output.
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High Quality - This option is for high quality output regardless of the speed.
High Resolution - This option is for printing in Decomposer resolution.

Basic Features - Allows you to configure the basic RGB color correction settings.
Advanced Features - Allows you to configure the advanced RGB and CMYK color 
correction settings.
Image Adjustment - Displays the [Image Adjustment] dialog box where you can 
configure RGB and CMYK color correction settings. Only [RGB Gamma Correction] is 
available if you selected the [Basic Features] radio button.

RGB Color Correction - Sets the color correction method for the RGB images on 
your document. 

-  Perceptual - Optimizes the rendering of photographic images by preserving all 
tonal gradations.

-  Saturation - Optimizes the rendering of business graphics by preserving the 
saturation of colors.

-  Relative Colorimetric - Preserves in-gamut colors and represents out-of-
gamut colors by the closest match.

-  Absolute Colorimetric - Does not map the white in images to the white of the 
output paper. Depending on the [RGB Color Temperature] setting, the white in 
images may be printed with a tint of color.

Source RGB Profile - Sets an RGB profile. The [Source RGB Profile] setting will be 
applied in conjunction with the [RGB Color Correction] setting. [Adobe RGB (1998)] 
is the RGB profile of Adobe Systems Incorporated. [Adobe RGB (1998)] may not 
accurately reproduce the tones of highly saturated graphics.
RGB Gamma Correction - Adjusts the brightness of the RGB images on your 
document. Select a value depending on the monitor being used. The larger the 
value, the darker the output. 
RGB Color Temperature - Adjusts the color temperature of your monitor to match 
the on-screen colors to the printed output colors.

-  5000K (D50) - Colors become slightly more yellowish than [6500K (D65)]
-  6500K (D65)
-  9300K - Colors become slightly more bluish than [6500K (D65)].

CMYK Color Correction - Sets the color correction method for the CMYK images 
on your document.

-  Auto Correction - Selects the color correction method commonly used in your 
region.

-  Japan Color 2001 - Selects Japan Color 2001 as the color correction method.
-  SWOP - Selects SWOP as the color correction method.
-  Euro Sheet-fed - Selects Euro Sheet-fed as the color correction method.
-  No Correction - Disables this feature.

Target Paper - Sets the type of paper for CMYK color correction. This is not the 
paper for printing. 



Installation and Configuration on Mac OS

70

-  Auto - Selects the type of target paper commonly used in your region.
-  Art - Selects Art as the target paper type.
-  Coated - Selects Coated as the target paper type.
-  Matt - Selects Matt as the target paper type.

Image Type - Sets the type of your document.
NOTE: [Image Type] appears only when [Basic Features] is selected. When 
[Advanced Features] is selected, [RGB Color Correction] and [CMYK Color 
Correction] appear instead, which are identical to those in the [Image Adjustment] 
dialog box.

Standard - Optimizes the printing of business documents that consist of text and 
graphs.
Photos - Suitable for printing photographic images and optimizes the reproduction 
of gradations. This is ideal for images represented in sRGB. 
Presentation - Suitable for printing presentation materials that need vibrant colors.
Web Pages - Suitable for printing images displayed on your computer screen, such 
as web pages.
CAD - Suitable for printing images that contain thin lines or small text.
POP - Suitable for printing colorful images.
Off - Does not perform color correction.

Screen - Adjusts the image quality of your document. 
Auto Screening - Automatically adjusts the image quality based on the type of the 
document.
Fineness - Optimizes the reproduction of text and lines.
Standard - Optimizes the reproduction of photographic images.
Gradation - Optimizes the reproduction of charts and graphs.

Color Balance - Clicking the button displays the [Color Balance] dialog box.
Adjust Color Balance - Selecting the check box allows you to adjust the density of 
the CMYK (cyan/magenta/yellow/black) toner. 
Target Color - Allows you to select a color.
Highlights -3 to 3, Midtones -3 to 3, Shadows -3 to 3 - Fine-tunes the density of 
the CMYK (cyan/magenta/yellow/black) toner.
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Job Accounting (Mac OS X 10.3.9/10.4)
The following explains how to configure the [Job Accounting] dialog box.

1. On your application, click [Print] from the [File] menu.

The [Print] dialog box appears.

2. Select [Job Accounting].

3. Set the desired features.

Setting items 
Account Mode - Sets whether to allow all users or only the System Administrator to 
change the user ID and authentication settings. 
User Prompt - Specifies the type of ID information used for authentication.
If [All] is selected, the [User ID], [Account ID], and [Billing ID] boxes will become 
available on the [User Details Setup] and [Enter User Details] dialog boxes.
If [User ID/Account ID] is selected, the [User ID] and [Account ID] boxes will become 
available. If [Billing ID Only] is selected, only the [Billing ID] box will become available.
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In conjunction with the [Customize User Prompts] setting in the [Installable Options] 
dialog box, this feature allows you to restrict the type of authentication information that 
a user can enter. 
User Details Setup - Displays the [User Details Setup] dialog box.

Always Use Default User Details - Sets whether or not to use the user ID and 
authentication settings in this dialog box every time you request a print job. 
User ID Options

-  Use Login Name - Uses your Macintosh login ID as the user ID. Selecting this 
enters the Macintosh login ID in [User ID] and makes it unchangeable. The user 
ID can be up to 32 alphanumeric characters. The ID becomes invalid if it 
exceeds 32 characters.

-  Enter User ID - Allows you to set a custom user ID in [User ID]. 
User ID - Sets a custom user ID with up to 32 alphanumeric characters.
NOTE: When the Authentication feature is enabled on the printer, the [User ID] 
must be the same as that registered on the printer. Otherwise, your job will not be 
printed. If the Authentication feature is not enabled, your job will be printed 
regardless of the [User ID] setting.

Passcode (next to [User ID]) - Sets the passcode for the user ID using 4 to 12 
alphanumeric characters. The passcode is optional.
Account ID - Allows you to enter an account ID with up to 32 alphanumeric 
characters.
Billing ID - Allows you to enter a billing ID for Charge Print with up to 8 alphanumeric 
characters.
Passcode (next to [Billing ID]) - Sets the passcode for the billing ID with up to 12 
alphanumeric characters. The passcode is optional.
Prompt User for Entry when Submitting Job - Selecting this button displays a 
dialog box that prompts you to enter your ID information every time you request a 
print job. Your job will be printed if you enter the ID and passcode (if one is set up) 
into the dialog box.
– Display Last Entered User Details - Selecting the check box saves the details 

of ID information entered in the [Enter User Details] dialog box and displays them 
as the defaults the next time you display the dialog box. 

– Mask User ID - Selecting the check box hides the user ID behind asterisks.
– Mask Account ID - Selecting the check box hides the account ID behind 

asterisks.
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Job Type (Mac OS X 10.3.9/10.4)
The following explains how to configure the [Job Type] dialog box.

1. On your application, click [Print] from the [File] menu.

The [Print] dialog box appears.

2. Select [Job Type].

3. Set the desired features.

Setting Items 
Job Type - Sets the type of your print job to [Normal Print], [Secure Print], [Sample Set], 
or [Delayed Print].

Normal Print - Prints a job without using the Secure Print, Sample Set, or Delayed 
Print feature.
Secure Print - Temporarily stores a print job in the printer, rather than printing it 
immediately, until you manually start the printing from the control panel.
Sample Set - Allows you to print a proof copy of a multi-set job and prints the entire 
sets once the print result has been verified. 
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Delayed Print - Temporarily stores a print job in the printer and prints the data at a 
specified time.
NOTE: To select [Secure Print], [Sample Set], and [Delayed Print], [Hard Disk] 
under [Installable Options] must be selected.

Setup - Selecting [Secure Print], [Sample Set], or [Delayed Print] displays the [Setup] 
dialog box, allowing you to configure the detailed settings.

User ID - Sets the user ID for the Secure Print or Sample Set feature with up to 8 
alphanumeric characters.
Secure Print Passcode - Sets the passcode associated with the user ID for the 
Secure Print feature. The passcode can be a 1 to 12 digit number. Asterisks (***) 
appear instead of text as you enter the passcode into this text box.
Start Print Time - Sets when to print the Delayed Print job. Click the hour or minute 
area, and press the up or down triangle to specify the start time. Alternatively, you 
can enter the time directly into the box. The default setting is 0:00.
Document Name - Sets the method of specifying the name of a document that will 
be stored in the printer using the Secure Print, Sample Set, or Delayed Print feature. 
[Use Existing Name] automatically retrieves the document name from the 
application from which the document will be printed. If the name exceeds 12 
alphanumeric characters, only the first 12 characters will be valid. 
New Document Name - If [Document Name] is set to [Enter Document Name], 
enter the document name with up to 12 alphanumeric characters.
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Watermark (Mac OS X 10.3.9/10.4)
The following explains how to configure the [Watermark] dialog box.

1. On your application, click [Print] from the [File] menu.

The [Print] dialog box appears.

2. Select [Watermark].

3. Set the desired features.

Setting items 
Watermark - Allows you to select a watermark name from the list box. To create a new 
watermark, click [New]. To edit or delete an existing watermark, select the name of the 
watermark, and then click [Edit] or [Delete].
Edit - Displays the [Watermark] dialog box, where you can edit the watermark.
Delete - Deletes the selected watermark.
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New - Displays the [Watermark] dialog box, where you can create a new watermark. 
Up to 32 watermarks can be registered.

Name - Allows you to enter a name for the watermark. Up to 32 characters are 
allowed.
Preview - Previews the watermark according to the settings in the dialog box.
Text - Allows you to enter a text string for the watermark. Up to 64 characters are 
allowed.
Text Color - Displays the [Colors] dialog box, where you can define the color of the 
watermark text string.
Fonts - Sets the font of the watermark text string.
Size - Sets the size of the watermark text string.
Angle - Sets the angle of the watermark text string from 0 to 360 degrees in units of 
1 degree.
Density - Sets the density of the watermark text string from 0 to 100% in units of 1 
percent.
Position (from center) - Sets the position of the watermark text string in millimeters 
or inches.
Millimeters - Sets the unit for [Position (from center)] to millimeters.
Inches - Sets the unit for [Position (from center)] to inches.
Center - Sets the position of the watermark text string to the center of the page.

Print on Page 1 only - Prints the watermark only on the first page. If unchecked, the 
watermark will be printed on every page.
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Installing the Screen Fonts

This section describes how to install the screen fonts from the PostScript Driver Library 
CD-ROM provided with the printer.
Install the fonts appropriate for the PostScript software kit in use.

1. Start your Macintosh computer.

2. Insert the PostScript Driver Library CD-ROM into the CD-ROM drive. 
The [FXOPS-PS] icon appears on the desktop.

3. Double-click the [FXOPS-PS] icon. 
The [FXOPS-PS] window appears.

4. Click the [English] folder, the [Utility] folder, and then the [MacScreen Font] folder.

5. Use Stufflt Expander to decompress MacFont.sea.hqx.

For Mac OS 8.6/9.2.2:
1) Copy all the files stored in the required font folder, and then paste them into 

[System Folder] on your Macintosh. 
2) Click [OK].

For Mac OS X 10.3.9/10.4:
1) Copy all the files stored in the required font folder, and then paste them into 

[Fonts] under the [Library] folder on your Mac OS X.

6. Restart your Macintosh computer.

NOTE: Store the CD-ROM in a safe place.
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3 Barcode Settings

This chapter contains the following information:

• About Barcodes
– Font Types and Character Codes
– Sample Program and Output Result

• Character Code Tables
– JAN Character Code Table
– Code 39 Character Code Table
– NW7 Character Code Table
– Code 128 Character Code Table
– ITF (Interleaved 2 of 5) Character Code Table
– Customer Barcode Character Code Table

• Barcode Sizes

About Barcodes

This section describes the supported types of barcodes, the character codes assigned 
to each barcode character, and the sizes of barcodes that can be printed. This chapter 
assumes that you have basic knowledge of barcodes.

Font Types and Character Codes
The following table lists the supported types of barcodes.
For information on the character codes used to specify each barcode character, see 
Character Code Tables on page 81.
For information on the sizes of barcodes that can be printed, see Barcode Sizes on 
page 91.

Barcode Type PostScript Font Name Character Code

JAN HitachiITHINJANH8-RG "JAN Character Code Table" (P. 81)

Code 39 HitachiIT-C39H8 "Code 39 Character Code Table" (P. 
82)

NW7 HitachiITHINNW7H8-RG "NW7 Character Code Table" (P. 83)
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NOTE: The readability of barcodes is affected largely by the quality of the output 
paper and the performance of barcode readers.
Before using this feature, we advise you to test it thoroughly in the environment it will 
be used.

Sample Program and Output Result
The Barcode feature provides a sample program that prints a typical barcode and a 
PDF file of its output result. Use this sample as a reference when printing barcodes. 

• Directory of the Sample Program/Output Result (PDF) 
"manual" folder > "sample" folder on the PostScript Driver Library CD-ROM

• Name of the Sample Program
Sample.ps

• PDF File Name of the Output Result
Sample.pdf

Code 128 HitachiITHINC128H8-RG "Code 128 Character Code Table" (P. 
84)

ITF
(without bearer bars)

HitachiITHINITFH8-RG "ITF (Interleaved 2 of 5)
Character Code Table" (P. 88)

ITF
(with bearer bars)

HitachiITHINITFB-RG

Customer Barcode HitachiITHINPOSTBC-RG "Customer Barcode Character Code 
Table"(P. 90)

Barcode Type PostScript Font Name Character Code

Font Type PostScript Font Name

OCR B LetterPress M OCRBLetM
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Character Code Tables

This section describes the character codes used when specifying each barcode 
character. 

JAN Character Code Table
The character codes used when printing JAN barcode characters are as follows:

Character

Character Code

Left-side Odd Parity Left-side Even Parity Right-side Even Parity

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

0 30 0 41 A 4B K

1 31 1 42 B 4C L

2 32 2 43 C 4D M

3 33 3 44 D 4E N

4 34 4 45 E 4F O

5 35 5 46 F 50 P

6 36 6 47 G 51 Q

7 37 7 48 H 52 R

8 38 8 49 I 53 S

9 39 9 4A J 54 T

Left-side 
guard bar

22 "

Right-side 
guard bar

23 #

Center bar 21 !
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Code 39 Character Code Table
The character codes used when printing Code 39 barcode characters are as 
follows:

Character

Character Code

Character

Character Code

Character

Character Code

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

$ 24 $ 8 38 8 M 4D M

% 25 % 9 39 9 N 4E N

* 2A * (SP) 20 SP O 4F O

+ 2B + A 41 A P 50 P

- 2D - B 42 B Q 51 Q

. 2E . C 43 C R 52 R

/ 2F / D 44 D S 53 S

0 30 0 E 45 E T 54 T

1 31 1 F 46 F U 55 U

2 32 2 G 47 G V 56 V

3 33 3 H 48 H W 57 W

4 34 4 I 49 I X 58 X

5 35 5 J 4A J Y 59 Y

6 36 6 K 4B K Z 5A Z

7 37 7 L 4C L (SP) 40 @
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NW7 Character Code Table
The character codes used when printing NW7 barcode characters are as follows:

Character

Character Code

Character

Character Code

Character

Character Code

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

$ 24 $ 0 30 0 A 41 A

+ 2B + 1 31 1 B 42 B

- 2D - 2 32 2 C 43 C

. 2E . 3 33 3 D 44 D

/ 2F / 4 34 4 A 61 a

5 35 5 B 62 b

6 36 6 C 63 c

7 37 7 D 64 d

8 38 8

9 39 9

: 3A :
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Code 128 Character Code Table
The character codes used when printing Code 128 barcode characters are as follows:

Value

Character Code Character Code

CODE A CODE B CODE C HEX 
Notation

ASCII 
Notation

0 SP SP 00 20 SP

1 ! ! 01 21 !

2 " " 02 22 "

3 # # 03 23 #

4 $ $ 04 24 $

5 % % 05 25 %

6 & & 06 26 &

7 ' ' 07 27 '

8 ( ( 08 28 (

9 ) ) 09 29 )

10 * * 10 2A *

11 + + 11 2B +

12 , , 12 2C ,

13 - - 13 2D -

14 . . 14 2E .

15 / / 15 2F /

16 0 0 16 30 0

17 1 1 17 31 1

18 2 2 18 32 2

19 3 3 19 33 3

20 4 4 20 34 4

21 5 5 21 35 5

22 6 6 22 36 6

23 7 7 23 37 7

24 8 8 24 38 8

25 9 9 25 39 9

26 : : 26 3A :

27 ; ; 27 3B ;

28 < < 28 3C <

29 = = 29 3D =

30 > > 30 3E >
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31 ? ? 31 3F ?

32 @ @ 32 40 @

33 A A 33 41 A

34 B B 34 42 B

35 C C 35 43 C

36 D D 36 44 D

37 E E 37 45 E

38 F F 38 46 F

39 G G 39 47 G

40 H H 40 48 H

41 I I 41 49 I

42 J J 42 4A J

43 K K 43 4B K

44 L L 44 4C L

45 M M 45 4D M

46 N N 46 4E N

47 O O 47 4F O

48 P P 48 50 P

49 Q Q 49 51 Q

50 R R 50 52 R

51 S S 51 53 S

52 T T 52 54 T

53 U U 53 55 U

54 V V 54 56 V

55 W W 55 57 W

56 X X 56 58 X

57 Y Y 57 59 Y

58 Z Z 58 5A Z

59 [ [ 59 5B [

60 \ \ 60 5C \

61 ] ] 61 5D ]

62 ^ ^ 62 5E ^

63 _ _ 63 5F _

64 NUL ` 64 60 `

65 SOH a 65 61 a

Value

Character Code Character Code

CODE A CODE B CODE C HEX 
Notation

ASCII 
Notation
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66 STX b 66 62 b

67 ETX c 67 63 c

68 EOT d 68 64 d

69 ENQ e 69 65 e

70 ACK f 70 66 f

71 BEL g 71 67 g

72 BS h 72 68 h

73 HT I 73 69 I

74 LF j 74 6A j

75 VT k 75 6B k

76 FF l 76 6C l

77 CR m 77 6D m

78 SO n 78 6E n

79 SI o 79 6F o

80 DLE p 80 70 p

81 DC1 q 81 71 q

82 DC2 r 82 72 r

83 DC3 s 83 73 s

84 DC4 t 84 74 t

85 NAK u 85 75 u

86 SYN v 86 76 v

87 ETB w 87 77 w

88 CAN x 88 78 x

89 EM y 89 79 y

90 SUB z 90 7A z

91 ESC { 91 7B {

92 FS | 92 7C |

93 GS } 93 7D }

94 RS ~ 94 7E ~

95 US DEL 95 7F DEL

96 FNC 3 FNC 3 96 A1

97 FNC 2 FNC 2 97 A2

98 SHIFT SHIFT 98 A3

99 CODE C CODE C 99 A4

100 CODE B FNC 4 CODE B A5

Value

Character Code Character Code

CODE A CODE B CODE C HEX 
Notation

ASCII 
Notation
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101 FNC 4 CODE A CODE A A6

102 FNC 1 FNC 1 FNC 1 A7

103 START(CODE A) A8

104 START(CODE B) A9

105 START(CODE C) AA

106 STOP AB

Value

Character Code Character Code

CODE A CODE B CODE C HEX 
Notation

ASCII 
Notation
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ITF (Interleaved 2 of 5) Character Code Table
The character codes used when printing ITF barcode characters are as follows:

Character

Character Code

Character

Character Code

Character

Character Code

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

00 21 ! 30 3F ? 60 5D ]

01 22 " 31 40 @ 61 5E ^

02 23 # 32 41 A 62 5F _

03 24 $ 33 42 B 63 60 `

04 25 % 34 43 C 64 61 a

05 26 & 35 44 D 65 62 b

06 27 ' 36 45 E 66 63 c

07 28 ( 37 46 F 67 64 d

08 29 ) 38 47 G 68 65 E

09 2A * 39 48 H 69 66 F

10 2B + 40 49 I 70 67 G

11 2C , 41 4A J 71 68 H

12 2D - 42 4B K 72 69 I

13 2E . 43 4C L 73 6A J

14 2F / 44 4D M 74 6B K

15 30 0 45 4E N 75 6C L

16 31 1 46 4F O 76 6D M

17 32 2 47 50 P 77 6E N

18 33 3 48 51 Q 78 6F O

19 34 4 49 52 R 79 70 P

20 35 5 50 53 S 80 71 Q

21 36 6 51 54 T 81 72 R

22 37 7 52 55 U 82 73 S

23 38 8 53 56 V 83 74 T

24 39 9 54 57 W 84 75 U

25 3A : 55 58 X 85 76 V

26 3B ; 56 59 Y 86 77 W

27 3C < 57 5A Z 87 78 X

28 3D = 58 5B [ 88 79 Y

29 3E > 59 5C \ 89 7A Z

90 7B { 94 A1 DEL 98 A5
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ITF barcodes represent a pair of a BAR character (character denoted with a bar) and a SPACE character 
(character denoted with a space) with one character code.
A single START character or STOP character is represented with one character code.

Example:
To print a pair of a BAR character representing “3” and a SPACE character representing “7”, specify “46” 
(HEX notation).
To print a pair of a BAR character representing “7” and a SPACE character representing “3”, specify “6A” 
(HEX notation).

91 7C | 95 A2 99 A6

92 7D } 96 A3 START A7

93 7E ~ 97 A4 STOP A8

Character

Character Code

Character

Character Code

Character

Character Code

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation
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Customer Barcode Character Code Table
The character codes used when printing customer barcode characters are as follows:

Character

Character Code

Character

Character Code

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

START 3C < CC1 61 a

STOP 3E > CC2 62 b

- 2D - CC3 63 c

0 30 0 CC4 64 d

1 31 1 CC5 65 e

2 32 2 CC6 65 f

3 33 3 CC7 67 g

4 34 4 CC8 68 h

5 35 5

6 36 6

7 37 7

8 38 8

9 39 9
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Barcode Sizes

The formulas for determining the approximate print sizes of barcodes are as follows.
The print sizes of barcodes vary depending on the characteristics of the printer, print 
resolution, output paper, and other factors even when the same program is used. The 
sizes derived from the following formulas do not guarantee the actual sizes of 
barcodes. Use them only as a reference.

P: Font size (point)
C: Number of characters
C1: Number of characters (0,1,2,3,4,5,6,7,8,9,-,$)
C2: Number of characters (:,/,.,+,A,B,C,D)

Barcodes
type

Formula

Width Height

JAN (standard) P × 0.502 P × 0.352

Side margins not included. Indicates the height of the guard bar.

JAN (short version) P × 0.354 P × 0.352

Side margins not included. Indicates the height of the guard bar.

Code 39 P × (C + 2) x 0.106 P × 0.352

Intercharacter gap of the left and right 
sides not included.
"C" includes the checkdigit.

NW7 P × (C1 × 0.132 + C2 × 0.148 - 0.026) P × 0.352

Intercharacter gap of the left and right 
sides not included.
“C1” and “C2” include the checkdigit.

Code 128 P × (C x 0.081 + 0.096) P × 0.352

Formula for CODE C.

ITF
(without bearer bar)

P × ((C/2 × 0.175) +0.093) P × 0.352

Quiet zone not included.
“C” includes the checkdigit.

ITF
(with bearer bar)

P × ((C/2 × 0.137) + 0.323) P × 0.352

Bearer bar and quiet zone included.
“C” includes the checkdigit.

Bearer bar included.

Customer Barcode P × 7.297 P × 0.342

Spaces before the black bar of START 
code and after the black bar of the STOP 
code are not included.

Indicates the height of the long bar.
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4 Appendix

Built-in Fonts

The following 136 PostScript fonts and barcode/OCR-B fonts are built into the printer.

Albertus

Albertus Italic

Albertus Light

Antique Olive Bold

Antique Olive Compact

Antique Olive Italic

Antique Olive Roman

Apple Chancery

Arial

Arial Bold

Arial Bold Italic

Arial Italic

Bodoni Bold

Bodoni Bold Italic

Bodoni Italic

Bodoni Poster

Bodoni Poster Compressed

Bodoni Roman

Carta

Chicago

Clarendon Bold

Clarendon Light

Clarendon Roman

Cooper Black

Cooper Black Italic

Copperplate Gothic 32BC

Copperplate Gothic 33BC
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Coronet

Courier

Courier Bold

Courier Bold Oblique

Courier Oblique

Eurostile Bold

Eurostile Bold Extended No. 2

Eurostile Extended No. 2

Eurostile Medium

Geneva

Gill Sans

Gill Sans Bold

Gill Sans Bold Italic

Gill Sans Condensed

Gill Sans Condensed Bold

Gill Sans Extra Bold

Gill Sans Italic

Gill Sans Light

Gill Sans Light Italic

Goudy Bold

Goudy Bold Italic

Goudy Extra Bold

Goudy Oldstyle

Goudy Oldstyle Italic

Helvetica

Helvetica Bold

Helvetica Bold Oblique

Helvetica Condensed

Helvetica Condensed Bold

Helvetica Condensed Bold Oblique

Helvetica Condensed Oblique

Helvetica Narrow

Helvetica Narrow Bold

Helvetica Narrow Bold Oblique

Helvetica Narrow Oblique

Helvetica Oblique
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Hoefler Ornaments

Hoefler Text

Hoefler Text Black

Hoefler Text Black Italic

Hoefler Text Italic

ITC Avant Garde Gothic Book

ITC Avant Garde Gothic Book Oblique

ITC Avant Garde Gothic Demi

ITC Avant Garde Gothic Demi Oblique

ITC Bookman Demi

ITC Bookman Demi Italic

ITC Bookman Light

ITC Bookman Light Italic

ITC Lubalin Graph Book

ITC Lubalin Graph Book Oblique

ITC Lubalin Graph Demi

ITC Lubalin Graph Demi Oblique

ITC Mona Lisa Recut

ITC Zapf Chancery Medium Italic

ITC Zapf Dingbats

Joanna

Joanna Bold

Joanna Bold Italic

Joanna Italic

Letter Gothic

Letter Gothic Bold

Letter Gothic Bold Slanted

Letter Gothic Slanted

Marigold

Monaco

New Century Schoolbook Bold

New Century Schoolbook Bold Italic

New Century Schoolbook Italic

New Century Schoolbook Roman

New York

Optima Bold
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Optima Bold Italic

Optima Italic

Optima Roman

Oxford

Palatino Bold

Palatino Bold Italic

Palatino Italic

Palatino Roman

Stempel Garamond Bold

Stempel Garamond Bold Italic

Stempel Garamond Italic

Stempel Garamond Roman

Symbol

Tekton Regular

Times Bold

Times Bold Italic

Times Italic

Times Roman

Times New Roman

Times New Roman Bold

Times New Roman Bold Italic

Times New Roman Italic

Univers 45 Light

Univers 45 Light Oblique

Univers 53 Extended

Univers 53 Extended Oblique

Univers 55

Univers 55 Oblique

Univers 57 Condensed

Univers 57 Condensed Oblique

Univers 63 Extended Bold

Univers 63 Extended Bold Oblique

Univers 65 Bold

Univers 65 Bold Oblique

Univers 67 Condensed Bold

Univers 67 Condensed Bold Oblique
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Wingdings

OCR-B Letterpress M

Hitachi-IT Barcode Code39 H8

Hitachi-IT Barcode Code128 H8

Hitachi-IT Barcode ITFB

Hitachi-IT Barcode ITF H8

Hitachi-IT Barcode JAN H8

Hitachi-IT Barcode NW-7 H8

Hitachi-IT Barcode POSTBC
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Notes and Restrictions

Print Driver
The notes and restrictions that apply to each PostScript print driver is described in 
"Readme.txt" in the PostScript Driver Library CD-ROM. Make sure to read the file 
before installing a print driver to your computer.

Troubleshooting
Refer to the User Guide for the error codes and error messages that appear on the 
control panel, and for instructions on how to clear paper jams.
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